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1 Introducing UNICORN System
Control

About this chapter
This chapter contains:

• A general introduction to System Control using the UNICORN software.

• Information about the user documentation for UNICORN, including an overview
of related documents describing the use of the software.

In this chapter

Section See page

1.1 About this manual 4

1.2 About System Control of UNICORN 6

1.3 Important user information 7

1.4 Associated documentation 8

Software declaration of
conformity

UNICORN 7.5 is technically compatible with all relevant sections of FDA 21 CFR Part
11.

A part 11-system assessment checklist is available on request from your local GE
Healthcare representative.

1 Introducing UNICORN System Control
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1.1 About this manual

Purpose of this manual
The purpose of the UNICORN System Control Manual is to provide a guide describing
the general system control functions in UNICORN. It includes general operation, sys-
tem settings and instructions on how to perform a chromatography run. It covers the
features and tools included in the System Control module of the UNICORN software
with practical instructions.

The manual covers the following:

• general UNICORN operation, including log on and log off.

• how to perform a run

• how to change system settings.

Refer to the instrument's Operating Instructions for further information on how to
perform a run.

Note: The UNICORN System Control Manual does not describe the functions of
every command in all panes and dialog boxes of the user interface. Refer to
the online help for information about commands that are not described in
this manual. The online help in the System Control module is accessed ei-
ther by clicking help buttons in software dialog boxes, by pressing the F1
key, or clicking Help for System Control on the Help menu.

Typographical conventions
Menu commands, field names and other text items from the software are quoted ex-
actly as they appear on the screen, in a bold italic typeface:

Example: Result Navigator, Method Navigator, Method Navigator, UNICORN
User Setup etc.

Menu paths are shown in a bold italic typeface with a separating colon between each
level:

Tools →UNICORN User Setup i.e., the menu option UNICORN User Setup from the
Tools menu.

Controls on the instrument, computer or keyboard keys are shown with a bold, regu-
lar typeface:

Example: Press the Delete key.

Text that the user must either type exactly as shown in the manual, or that UNICORN
displays as a response (not a regular part of the graphic user interface), is represen-
ted by a monospaced typeface:

Example: Connection change

1 Introducing UNICORN System Control
1.1 About this manual
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File system paths are represented by a monospaced typeface:

Example: C:\Program Files\GE Healthcare\UNICORN\

1 Introducing UNICORN System Control
1.1 About this manual
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1.2 About System Control of UNICORN

Introduction
This section is a brief introduction to the control system used in UNICORN.

What is UNICORN?
UNICORN is a complete software package for:

• control and supervision of chromatography systems.

• evaluation and analysis of the results from separation runs.

Description of the System Control
module

The System Control module is used to start, monitor and control a chromatography
run.

Runs can be performed in three different ways, as listed below:

• Using a preprogrammed method without any manual interactions.

• Interact with the instrument during a method run by performing manual instruc-
tions.

• Perform manual runs. This approach may be useful for simpler procedures such
as priming tubing with buffer.

1 Introducing UNICORN System Control
1.2 About System Control of UNICORN
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1.3 Important user information

Read this before running System
Control

All users must read the entire Operating Instructions before installing, operat-
ing or maintaining the chromatograpy system, and running System Control.

Always keep the Operating Instructions at hand when operating System Control.

Do not operate the chromatograpy system in any other way than described in the
user documentation. If you do, you may be exposed to hazards that can lead to per-
sonal injury and you may cause damage to the equipment.

1 Introducing UNICORN System Control
1.3 Important user information
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1.4 Associated documentation

Introduction
This section describes the user documentation that is delivered with UNICORN.

User documentation
The user documentation listed in the table below is available from the Help menu in
UNICORN and as printed books.

Document Main contents

UNICORN Method Manual Overview and detailed descriptions of
the method creation features in
UNICORN. Instructions on how to use
the software. Workflow descriptions
for common operations.

UNICORN Evaluation Manual Overview and detailed descriptions of
the Evaluation Classic module. Work-
flow descriptions for common opera-
tions. Description of the evaluation al-
gorithms used in UNICORN.

Overview and detailed descriptions of
the evaluation features in UNICORN.
Instructions on how to use the soft-
ware. Workflow descriptions for com-
mon operations. Description of the
evaluation algorithms used in
UNICORN.

UNICORN Administration and
Technical Manual

Overview and detailed description of
network setup and complete software
installation. Administration of
UNICORN and the UNICORN database.

UNICORN System Control Manual Overview and detailed description of
the system control features in
UNICORN. Includes general operation,
system settings and instructions on
how to perform a run.

UNICORN Contextual Help Dialog box descriptions for UNICORN
(from the Help menu).

1 Introducing UNICORN System Control
1.4 Associated documentation
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2 General UNICORN operation

About this chapter
This chapter includes a description of general UNICORN operation which includes log
on and log off UNICORN, how to structure files and folders and how to use the Online
Help.

In this chapter

Section See page

2.1 Log on and log off routines 10

2.2 Help functions 13

2 General UNICORN operation
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2.1 Log on and log off routines

Start UNICORN and log on

Follow the instructions to start UNICORN and log on to the program. A valid e-license
must be available for the workstation. See UNICORN Administration and Technical
Manual for more information about e-licenses.

Step Action

1 Double-click the UNICORN icon on the desktop.

Result:

The Log On dialog box opens.

Note:

If there is no connection to the database it is still possible to log on to
UNICORN and control a running system. The Log On dialog box will give the
option to start System Control without a database. Click Start System
Control to proceed to the next Log On dialog box.

2 General UNICORN operation
2.1 Log on and log off routines
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Step Action

2 In the Log On dialog box:

a. Click a user name in the User Name list

and

b. enter the password in the Password field.

Note:

It is also possible to select the Use Windows Authentication check box
and enter a network ID in the User Name box.

c. select which UNICORN modules to start.

d. click OK.

Result:

The selected UNICORN modules open.

Log off or exit UNICORN
Follow the instruction to log off or exit UNICORN. This can be performed from any of
the UNICORN modules.

If you want to... then...

log off UNICORN on the File menu, click Log off.

ResultAll open UNICORN modules close and the Log On
dialog box opens.

exit UNICORN on the File menu, click Exit UNICORN.

ResultAll open UNICORN modules close.

2 General UNICORN operation
2.1 Log on and log off routines
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Note: If an edited method or result is open and not saved when you try to exit or
log off UNICORN, you will see a warning. Click Yes to save, No to exit with-
out saving, or Cancel to stay logged on.

2 General UNICORN operation
2.1 Log on and log off routines
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2.2 Help functions

Default installation folders
In this document, "Program Files Path" is used to represent the default path for the
program files installation folder, depending on the Windows version. For example,
the default path to the program files folder where UNICORN is installed in a 64-bit in-
stallation of Windows 10 is C:\Program Files (x86).

For example, if the path is written as below you have to replace Program Files Path
with the correct path for your version of Windows:

Program Files Path \GE Healthcare\UNICORN\.

The help viewer application

As part of the UNICORN software installation, a special viewer for the online help is
installed. This application, the MadCap™ Help Viewer, is accessed from the
UNICORN user interface either by clicking help buttons in dialog boxes, by pressing
the F1 key or by clicking Help menu items.

By default, this application creates a shortcut icon on the desktop. If logon to
UNICORN fails, the online help can be opened using this shortcut.

To start the UNICORN Contextual help:

Step Action

1 Double-click the shortcut icon on your desktop.

2 On the File menu, click Open.

2 General UNICORN operation
2.2 Help functions
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Step Action

3 Browse to any of the folders:

a. Program Files Path \GE Healthcare\UNICORN\UNICORN 7.5\
Documentation\Help\Chromatography for a Chromatography
installation.
or

b. Program Files Path \GE Healthcare\UNICORN\UNICORN 7.5\
Documentation\Help\Bioreactor for a Cell Cultivation instal-
lation.
or

c. Program Files Path \GE Healthcare\UNICORN\UNICORN 7.5\
Documentation\Help\Filtration for a Filtration installation.

4 Select the file Manual.mchelp.

5 Click Open.

Result:

The online help portal page opens.

Note: Sometimes Windows needs to register the MadCap Help Viewer as the ap-
plication for files of the type .mchelp before it recognizes calls from help
buttons in UNICORN 7.5. If that happens, open the viewer manually as de-
scribed above. It can be necessary to do this once for a new Windows user
profile.

2 General UNICORN operation
2.2 Help functions
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3 The System Control module

In this chapter

Section See page

3.1 System Control module overview 16

About this chapter
This chapter gives an overview of the System Control module.

3 The System Control module
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3.1 System Control module overview

Illustration of the System Control
user interface

The illustration below shows the different panes and areas of the System Control
module.

1

2

3

4

Part Description

1 Run Data: Presents current run data values.

2 Chromatogram: Illustrates data as curves.

3 Process picture: Illustrates the current flow path.

4 Status bar: Shows information on instrument and database connec-
tion.

3 The System Control module
3.1 System Control module overview
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Select panes to display

The following instruction describes how to display panes:

Step Action

1 On the View menu.

2 Select which panes to display.

Result:

Selected panes will be displayed on the screen. The Method Navigator
with folders and methods will be displayed at the left side.

Instrument states
Information about the status of instrument connections and chromatography runs
are displayed as states. The different states are displayed in the System Control
module in Run Data and in the Status bar.

3 The System Control module
3.1 System Control module overview
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4 How to perform a run

About this chapter
This chapter includes a description of how to use the System Control module to
connect to a system and how to perform and monitor a run.

In this chapter

Section See page

4.1 Connect to system 19

4.2 Start a method run 21

4.3 Monitor a run 27

4.4 Manual system control 34

4.5 Method queue, Design of Experiments, Scouting and Buf-
ferPro runs

37

4 How to perform a run
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4.1 Connect to system

Connect instrument to UNICORN

Follow the instruction to connect the instrument to UNICORN.

Step Action

1 In the System Control module,

• click the Connect to Systems button,

or

a. on the System menu, click Connect to Systems.

Result:

The Connect to Systems dialog box opens.

4 How to perform a run
4.1 Connect to system

UNICORN 7.5 System Control Manual 29459128 AA 19



Step Action

2 In the Connect to systems dialog box:

a. Select a system by selecting the check box in front of the name.

• To control the selected system, click the Control option button.

• To view runs on the selected system, controlled by another user,
click the View option button.

b. Click OK.

Note:

Instruments that are turned off or disconnected from the network appear
dimmed and cannot be connected.

Tip:

To view the users currently connected to systems, either in control or view
mode, click Connected Users.

Result:

UNICORN states Connection = Connected in control or Connection =
Connected in view in the status bar in the lower part of the System Con-
trol window.

.

4 How to perform a run
4.1 Connect to system
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4.2 Start a method run

Select a method to run

Step Action

1 In the Method Navigator pane in the System Control module, select the
method to run.

2 • click the Run button in the toolbar,

or

• on the File menu click Run.

Result:

• If a Start Protocol was chosen when the method was created, the first
page of the Start Protocol opens. Default is Result Name and Loca-
tion.

• If no Start Protocol has been chosen, the Select Columns dialog box
opens.

• If Column type Any was chosen in the Method Settings phase, the
Select Columns dialog box does not open and the run starts immedi-
ately.

• If Column Logbook is not activated the Select Columns dialog box
does not open and the run starts immediately.

The Start protocol
The following table describes the different pages of the Start Protocol that can be
selected in the Method Settings phase when a method is created. Some pages are
system specific.

4 How to perform a run
4.2 Start a method run
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Page Description

Fraction collector Displays the Fraction collector setup; tube type and po-
sition.

Variable List Displays a list of all method variables and allows chang-
ing of variable values.

Scouting Displays a list of all scouting parameters and allows:

• Changing of parameter values.

• Inserting or removing scouting parameters.

• Inserting or removing scouting runs.

Text instructions Displays the text instructions of the method

Notes • A start notes tab allows adding of free text.

• A method notes tab allows viewing of text added at
method creation.

Note:

Run and Evaluation Notes will be available for adding of
free text during method run and evaluation respectively.
All notes will be present in the documentation in Evalua-
tion.

Gradient Displays the gradient programmed for the method. The
X-axis shows the theoretical duration of the method.

BufferPro Displays Q-inlet positions, used for BufferPro, and de-
scriptions for preparation of stock solutions included in
the selected BufferPro recipe.

Column Displays the column type chosen for the method as
well as column run parameters and ordering informa-
tion.

Note:

To get information about the chosen column position,
see Variable List.

4 How to perform a run
4.2 Start a method run
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Page Description

Evaluation Displays a list of available evaluation procedures. Se-
lected procedures will be run at the end of the method
run. The selected evaluation procedures may be edited
from this list. See UNICORN Evaluation Manual for
more information.

Note:

This information only applies to Evaluation Classic.

Method information • A properties tab displays information about crea-
tion and modification of the method: dates and
users.

• A method duration tab displays information about
approximate run time and volume.

• A signature tab displays information about method
signatures, if applicable.

System Settings Displays a list of current system settings.

Calibration Displays a list of the latest performed calibrations.

Questions Displays predefined questions and reminders.

Note:

Questions are defined when the method is created in the
Method Editor.

Changeable Batch ID Allows the user to change the Batch ID.

Note:

The Batch ID is displayed in the beginning of the run log.

Result Name and
Location

Displays run info, result location and name. Allows:

• Changing result location by using the browser.

• Changing name of Design of Experiment or Scout-
ing directory.

• Changing of result name.

4 How to perform a run
4.2 Start a method run
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Navigate in the Start protocol

Step Action

1 Make the necessary changes in the displayed page.

2 To proceed to next page, click Next.

3 In the last displayed page in the start protocol, click Start.

Result:

The Select Columns dialog box opens.

Note:

If Column Logbook is not activated or column type Any was chosen in the
Method Settings phase, the run starts immediately.

Column handling and method
start

The following instruction assumes that:

• Column Logbook is activated.

• A Column type has been selected when the method was created.

• A valid column license is used.

4 How to perform a run
4.2 Start a method run
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To register a column, see UNICORN Method Manual.

Step Action

1 Click Start on the last page of the Start Protocol.

Result:

The Select Columns dialog box opens.

4 How to perform a run
4.2 Start a method run
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Step Action

2 Select or enter a column ID according to one of the following options.

If you want to... then...

select a column from a list select Select ID and select the
column to be used from the list.

enter column ID manually select Enter ID and manually en-
ter the column code in the Code
box.

enter column ID using the 2D Bar-
code scanner

• select Enter ID

• make sure the cursor is in the
first position of the Code box.

• point the Barcode scanner to-
wards the data matrix tag on
the column.

• press and hold the trigger to
create a beam.

• when the Barcode scanner
beeps, the column ID is regis-
tered and displayed in the dia-
log box.

3 Click OK.

Result:

The run starts.

4 How to perform a run
4.2 Start a method run
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4.3 Monitor a run

Introduction
This section describes the data shown in System Control during a run, and the pro-
cedure to customize the view of the different panes. It also describes how to enable
alarm and error notifications.

You can follow the ongoing method run in the System Control module.

• The current system state is shown in the System state box in the Run Data
pane. For example, it may state Method Run, Wash or Hold.

• Selected curves are shown in the Chromatogram pane.

• The current flow path is shown in the Process Picture pane.

To find an overview of the System Control user interface, see Section 3.1 System
Control module overview, on page 16.

Pump wash
Note: If a pump wash is included in the method and an Alarm and Error state

occurs, click Continue twice to return to Run state.

Open the Customize dialog box
To customize displayed information and data in the different panes:

• Click the Customize button in the toolbar.

or

• Right-click in the different panes (except Process Picture) and click Customize.

Result:The Customize dialog box is opened.

4 How to perform a run
4.3 Monitor a run
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Note: Further information about the settings in the Customize dialog box can be
found in the Online Help.

Customize Run data

Tab in the Customize
dialog box

Customization

Run Data Groups Selects which run data to display in the Run Data pane.

Run Data Groups but-
tons:

• New Group

• Edit Group

• Delete Group

Standardize displayed run data by creating run data
groups.

Run Data Color Changes color of displayed data.

4 How to perform a run
4.3 Monitor a run
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Customize Chromatogram

Tab in the Customize
dialog box

Customization

Curves Chooses curves to be displayed.

Curve style and color Customizes the appearance of the displayed curves.

X-axis Chooses base unit (time or volume) and set axis scale.

Y-axis Sets scale for the different curves and select which ax-
es to display.

Customize Run Log
The Run Log pane displays registered actions during the run.

Tab in the Customize
dialog box

Customization

Run Log Selects what to display in the log.

Note:

All information in the run log is saved. The selections de-
fine what is displayed.

4 How to perform a run
4.3 Monitor a run
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Select and zoom a curve in the
chromatogram

The following instructions shows how to select a curve and to zoom in the chromato-
gram.

Command Instruction

Select a curve • Position the mouse marker over a curve name:

The curve line becomes bold to faciliate the identifi-
cation of desired curve.

• Click the curve:

The corresponding legend text is shown in bold type
and the Y-axis scale changes to the unit applicable
for the curve.

Zoom • Click and hold the left mouse button with the point-
er positioned in the top left corner of the area you
want to zoom in on.

• Drag the pointer downwards and to the right. A dot-
ted rectangle marks the selected area. Select the
area you want to zoom in on, and release the left
mouse button.

(The text Zoomed mode is shown in the chromato-
gram)

• To reset zoom, right-click and click Reset zoom.

• To reset the last zoom action, right-click and click
Undo zoom.

Right-click menu op-
tions

• Right-click and click options and actions. See Online
Help for information.

The Process Picture pane
The Process Picture pane shows the current flow path during the run. Color indica-
tion is applied and real-time data from monitors are shown.

The following illustrations show two examples of process pictures.

4 How to perform a run
4.3 Monitor a run
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The following table describes how color indicates used flow paths.

Color Indication

Green Open flow path

Gray Closed flow path

4 How to perform a run
4.3 Monitor a run
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Interact with the Process Picture
pane

For some systems it is possible to interact with the Process Picture pane.

• To open a related instruction, click or double-click on the component depending
on the system. For some systems a pop-up toolbar is shown. Instructions can be
given from the pop-up toolbar of each component.

• To find associated instructions for the component, right-click on the component
and click Instructions.

• To display a detailed picture with explanations, for example for a valve, right-click
on the component and click Show Details or Detailed picture depending on the
system.

See Perform manual instructions during a method run, on page 35 for more informa-
tion.

Alarm, warning and error
notifications

Alarms, warnings and errors might be displayed during the run. For more information
see Error messages and alarms, on page 48.

If an alarm, a warning or an error occurs during the run, it is possible to get a notifica-
tion sent to: the user that started the run; the user in control of the system; or to one
or more other specified e-mail addresses.

Note: This e-mail address setting is only for alarms, warnings and errors and dif-
fers from the e-mail address settings made in the Administration module.

Note: The users must define their e-mail addresses in the user profile to be able to
receive the e-mail notifications.

Follow the instructions to enable notifications for alarms, warnings and errors.

4 How to perform a run
4.3 Monitor a run
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Step Action

1 In the System Control module, on the System menu, click Notification
Settings.

Result:

The Notification Settings dialog box opens.

2 Select one or more of the available check boxes:

a. User that started the run

b. User in control of the system

c. Enter optional email addresses. Type in one or more e-mail addresses
in the empty text field. Separate multiple addresses with a semicolon.

3 Select for which occurrences notifications should be sent in the Notifica-
tion on check boxes.

4 Click Test Notification E-mail to test if the e-mail settings are correct.

5 Click OK.

4 How to perform a run
4.3 Monitor a run
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4.4 Manual system control

The toolbar
To hold, pause, continue or end a run, use the buttons in the toolbar.

The following table describes the function of these buttons.

Button Function

Hold Suspends the execution of the method, while liquid is still pumped at
the current flow rate and eluent concentration.

Pause Suspends the execution of the method and stops all pumps.

Contin-
ue

Resumes a held or paused run.

If the system is in the state Wash, or when Alarms and Errors have
been acknowledged, the system returns to the previous state.

End Terminates the run.

Run Starts a new method run, selected in the method navigator.

If a another method run is ongoing, a method queue will be created
and the new run will start when the ongoing run has ended.

Manual Instructions
To open the Manual Instructions dialog, use one of these options:

• On the Manual menu, click Execute Manual Instructions.

or

4 How to perform a run
4.4 Manual system control
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• Click or double-click on a component in the Process Picture (only available for
some systems).

or

• Double-click the arrows beside a selected data in the Run Data pane.

Note: For some systems it is possible to open the most relevant instruction by
clicking or double-clicking on a component in the Process Picture or in the
Run Data pane. By right-clicking, there is an option to select one instruc-
tion from a group of instructions associated with the component.

Perform manual instructions
during a method run

The following instruction is an example of how to manually interact with an ongoing
method run. The example shows how to increase the system flow.

Step Action

1 Open the Manual Instruction dialog box according to the above instruc-
tion.

2 In the Instructions list, select instruction group Pumps and pressures and
instruction System flow.

4 How to perform a run
4.4 Manual system control
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Step Action

3 Enter a new Flow rate value.

4 To execute several instructions at the same breakpoint, select and edit an
instruction and click Insert. Repeat for several instructions.

5 To update parameter fields during method run, select the Auto update of
parameters during run check box.

6 To perform the instructions, click Execute.

4 How to perform a run
4.4 Manual system control
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4.5 Method queue, Design of Experiments, Scouting and
BufferPro runs

Introduction
This section describes how to start method queues, Design of Experiment runs and
Scouting runs. Some preparations before a BufferPro run are also described.

Run method queues

A method queue with a number of methods is created in the Method Editor. See
UNICORN Method Manual for information.

The following instruction describes how to start and monitor a method queue that
was created in the Method Editor.

Step Action

1 In the Method Navigator in System Control, select the method queue
and click the Run button.

2 Click to start Immediately, or At time.

Result:

The Start protocols will be displayed for all methods in the method queue.

3 Navigate through the Start protocol as described in Navigate in the Start
protocol, on page 24. Click Start in the last page of the Start protocol.

4 Select a column in the Select Columns dialog box. See Column handling
and method start, on page 24.

Result:

The run starts.

4 How to perform a run
4.5 Method queue, Design of Experiments, Scouting and BufferPro runs
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Step Action

5 To view the status of the method queue, on the System menu, click Run-
ning methods.

6 To cancel a method, or change method sequence, select the row of the
method and use the buttons below the table.

Run DoE or Scouting methods

Design of Experiments (DoE) and Scouting methods are created in the Method Edi-
tor . See UNICORN Method Manual.

The following instruction describes how to start such a method.

Step Action

1 In the Method Navigator in System Control, select the Scouting/DoE
protocol and click the Run button.

4 How to perform a run
4.5 Method queue, Design of Experiments, Scouting and BufferPro runs
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Step Action

2 If a Scouting scheme was selected in the Start Protocol, the scheme is
displayed. The Scouting parameters can be edited, but the changes will
not affect the method, only the run.

3 a. Click Next.

b. Click Start in the last page of the Start protocol.

4 Select a column in the Select Columns dialog box. See Column handling
and method start, on page 24.

Result:

The run starts.

Run a BufferPro method

For information on how to create BufferPro methods, see UNICORN Method Manual.
BufferPro is a system specific function.

Step Action

1 Prepare stock solutions according to the BufferPro Properties of the
method.

2 Prepare the instrument for a BufferPro run according to the instrument's
user documentation.

4 How to perform a run
4.5 Method queue, Design of Experiments, Scouting and BufferPro runs
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Step Action

3 Select the BufferPro method in the Method Navigator and click the Run
button.

4 Navigate through the Start protocol as described in Navigate in the Start
protocol, on page 24. Click Start in the last page of the Start protocol.

5 Select a column in the Select columns dialog box. See Column handling
and method start, on page 24.

Result:

The run starts.

4 How to perform a run
4.5 Method queue, Design of Experiments, Scouting and BufferPro runs
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5 System Settings

About this chapter
Each installed instrument has a set of default parameter values, called system set-
tings. The System Settings dialog box in System Control is used to view and edit
the system settings for the currently selected instrument before the run is started.
This chapter describes how to edit the system settings.

Note: System settings depend on the instrument configuration. The system set-
tings shown in this section may differ from the settings that are applicable
for your specific instrument configuration.

Alternative paths for editing
System settings

The parameter values defined in System Settings are used as default values.

Some of the instructions listed in the system settings are also available as method
and manual instructions. When a run is started, the parameter values from the sys-
tem settings are valid. If the same instruction is executed from the method or man-
ually during a run, the parameter value of the new setting will be valid. Thus, it is al-
ways the parameter value of the instruction that was last executed that will be ap-
plied. When the run has ended, the parameter values are reset according to the sys-
tem settings.

The effect of changing the system settings depends on when it is performed, as de-
scribed in the table below. This section only describes settings available from the
Settings menu item on the System menu.

5 System Settings
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Edit System Settings

Follow the instruction to edit the System Settings.

Step Action

1 In the System Control module, on the System menu. click Settings.

Result:

The System settings dialog box opens with the Instructions displayed.
The instructions in the menu differ depending on the specific system. See
examples of different menus below.

or

2 Select the instruction to edit from the list. Click the + symbol to show the
instructions for each category. The instructions in each category differ de-
pending on the system.

3 Select settings and choose parameter values for the selected instruction.
Minimum and maximum values for each parameter are shown within
brackets by each field. Click OK.

4 To return to the default values defined in the instrument configuration,
click Reset to defaults.

5 System Settings
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Note: The System Settings are changed to new default values according to the
above instruction. If you manually change any of these values for a run in
the Text Instructions pane in Method Editor, or in the Manual Instruc-
tions dialog box in System Control, the changes only affect the current
run.

Enable power-save

Follow the instructions to enable power-save for the instrument.

Note: Power-save is a instrument specific functionality.

Step Action

1 In the System Control module, on the System menu, click Settings.

Result:

The System Settings dialog opens.

2 a. Select Advanced:Power-save

3 a. Click On

and

b. enter the number of minutes in the Time box.

Note:

This is the time the instrument will be in state Ready before power-save
mode is entered.

c. Click OK.

5 System Settings
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6 Troubleshooting

About this chapter
This chapter describes different operational scenarios which may arise in UNICORN,
and how to solve the problems or consequences.

Tip: For additional advice concerning operational scenarios and possible solu-
tions, refer to the UNICORN Information Letter. The UNICORN Information
Letters are available at www.gelifesciences.com/unicorn.

In this chapter
This chapter describes the following scenarios:

• User access problems

• Unable to access UNICORN functions

• Unable to connect or locate chromatography systems or workstations

• A displayed error message or alarm is incomprehensible

User Access

Problem description Solution

Username and password not accepted. • The UNICORN administrator
should check if the user account is
locked, for example after too many
unsuccessful log on attempts.

• The UNICORN administrator can
try to set a new password.

• If a password reset does not work,
the user profile may have to be de-
leted and a new profile created.

The log on dialog box is inactive and a
password cannot be entered.

1. Verify that no UNICORN window or
module is opened.

2. Log off from Windows and log on
again.

6 Troubleshooting
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Access to UNICORN functions

Problem description Solution

The Execute manual instruction
menu command in the System Con-
trol module is dimmed, that is you can
establish a connection but cannot con-
trol the system.

• Check that no other user has a con-
trol mode connection.

• Check that you have access rights
to control the system manually.

The help viewer cannot be opened us-
ing help buttons or the F1 key.

1. Open the MadCap help viewer from
the Windows desktop icon. This is
described in UNICORN
Administration and Technical
Manual.

2. Try the help button or F1 key again.

The Microsoft® Office Document Im-
age Writer causes UNICORN to termi-
nate.

This writer application will not work.
Choose another option, for example a
PDF writer application.

An error message is shown when a run
is started, stating that not enough disc
space is available.

1 GB of free disc space is required as
headroom before a run can be started,
to ensure that all data can be accom-
modated.

A user without access to the function
Method Pause may still pause a meth-
od using a Timer instruction.

Access to the Timer instruction must
also be disabled if users are not al-
lowed access to the Method Pause
function.

A user without access to the function
Method End may still pause a method
using a Timer instruction.

Access to the Timer instruction must
also be disabled if users are not al-
lowed access to the Method End func-
tion.

A manual run is started. A method run
is then started and a start protocol
opens. Before the start protocol is fin-
ished, an alarm is caused by the man-
ual run. The start protocol cannot be
completed and the method run cannot
start at this point. This is because the
alarm must be acknowledged first, but
no message about this is issued.

Either stop the manual run which will
allow the method run to start, or start
another method. This will add the sec-
ond method to the list of running
methods and the first method is al-
lowed to start.
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System connections

Problem description Solution

The connections are not available, that
is the selection check box is dimmed.

• Check if the chromatography sys-
tem has been deactivated.

• Check that the power to the chro-
matography system is turned on.

• Check the connection between the
PC and the chromatography sys-
tem.

The connections are not available even
though

• the connection between the PC
and chromatography system ap-
pears to be correct

• the power is turned on.

1. Switch off the chromatography sys-
tem.

2. Exit UNICORN.

3. Shut down the instrument server
computer.

4. Restart the chromatography sys-
tem.

5. Restart the instrument server com-
puter.

6. Log on to UNICORN.

A system is not available when you at-
tempt to establish a connection.

• Check that you have access rights
to the system. Access rights are not
automatically assigned for a newly
defined system.

• The system may not be active.

• Log off and log on again for access
rights changes to be applied.

6 Troubleshooting
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Problem description Solution

You receive the error message Can-
not connect to system... in a
network installation.

• Check that the local computer to
which the system is connected is
turned on and logged on to the net-
work.

• Check that the computer from
which you try to establish a con-
nection is logged on to the net-
work.

• Check that the limit of five simulta-
neous connections to the system
has not been exceeded.

You receive the error message Warn-
ing, system occupied when try-
ing to connect.

This error message is displayed if a sys-
tem is defined and active in two differ-
ent database instances and is already
connected in the other instance. It is
not recommended to have a system
defined and active in more than one
database instance.

You are connected to a system but
have no contact with the instrument.
The system hangs at initialization.

• Check that the instrument is
turned on.

• Check that all cable connections
are intact.

• Check that the system is config-
ured correctly, in System Proper-
ties and on the instrument display.

• If the above actions do not help, try
to restart both the instrument
server computer and the instru-
ment.

When attempting to connect to an in-
strument server, an error message is
displayed stating that the client con-
necting and the instrument server are
incompatible. In fact, it is the current
instrument configuration which is in-
compatible with the client UNICORN
installation.

Ensure that all client computer instal-
lations are compatible with the instru-
ment configurations used.

6 Troubleshooting
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Error messages and alarms
If a displayed error message or alarm is incomprehensible, contact your local GE
Healthcare representative.

6 Troubleshooting
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GE Healthcare Bio-Sciences AB
Björkgatan 30 751 84 Uppsala Sweden

www.gelifesciences.com/unicorn
GE, the GE Monogram, and UNICORN are trademarks of General Electric Company.

MadCap is a trademark of MadCap Software Incorporated. Windows and Microsoft are registered trademarks of Microsoft
Corporation.

All other third party trademarks are the property of their respective owners.

© 2019 General Electric Company

Any use of UNICORN is subject to GE Healthcare Standard Software End-User License Agreement for Life Sciences Software
Products. A copy of this Standard Software End-User License Agreement is available on request.

All goods and services are sold subject to the terms and conditions of sale of the company within GE Healthcare which
supplies them. A copy of these terms and conditions is available on request. Contact your local GE Healthcare representative
for the most current information.

For local office contact information, visit www.gelifesciences.com/contact
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